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Formalities

Document Scope

This is a user manual for the SediMeter™ software, version 5.1. It is intended as a reference to
assist users in getting the most out of the software. It is, however, not exhaustive, as the
application inherits many features and shortcuts from its development platform (LabView) that
are not documented here. Right-clicking on different parts of the user interface brings up context
sensitive menus that provide a wealth of options that are beyond the scope of this manual to
document.

Document Version
Present version rev. 5.1, 2019-09-27.

Software Scope

SediMeter.exe ver. 5 is the communication and data management application for SediMeter™
SM3 instruments having firmware revision 2, as well as for SM4 instruments and SediTrans™
ST1 instruments. SediMeter.exe 3.7 is the last version that supports SM3 firmware revision 1.

Supported Operating Systems
The application has been developed and tested under Windows 10.

Installation

Insert the memory stick or CD and follow the instructions. Do not change the default directories,
as it may prevent the software from working properly. You will get warnings that the software has
not being certified; this is normal (it would be cost prohibitive to certify the software, since every
time an update or customization was made it would have to be re-certified).

Drivers

The communication with the SediMeter™ instrument is through a USB to RS-485 adapter.
Download and install the driver from http://www ftdichip.com/Drivers/V CP.htm

Copyright

This manual, as well as the application it refers to, is ©Lindorm, Inc., 2006-2019. All rights
reserved. Contact copyright@lindorm.com to request permission to use the material.
SediMeter™ is a trademark of Lindorm, Inc.

Warranty

This software is supplied for free. No express or implied warranty is made regarding the
usefulness for a specific purpose, beyond to communicate with Lindorm’s SediMeter™
instruments.
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Please Note

Window Behavior

Windows in this application are “modal,” which means that you have to close the last window
opened to return to the previous window (the control is passed to the last window, so the underlying
window is non-responsive). Use the File = Close method to close a window; do not try to close it

using the Windows operating system (the X mark is turned off for that reason).

Important advice for project leaders

1. Have one person who has received training on the SediMeter available for the project at all
times. Taking the Lindorm course IAOO gives access to VIP support.

2. Take a photo (or video) using a wide angle camera of the point where the SediMeter enters
the seabed (or lakebed, etc) at the time of installation, and if possible also at the time of
retrieval.

3. If downloading data in real time via a third party system, download the entire raw data
record (with *.1d2 extension). This way the SediMeter software can open the data for
analysis.

Changes in version 5.1

Version 5.1 contains the COM driver that was missing in version 5.0, why this should be installed
by all users as the base version 5.

Real Time Monitoring

The maximum rate for real-time monitoring has been increased to more than once per second for
the first time. The only instrument that supports such high rates at the time of releasing this
software is SM3 in the latest firmware release. To enable rates up to 15 Hz the communication
protocol has been slightly modified in SM3, so that the instrument replies with data after a Cmd-
N (new measurement command) without waiting for explicit instruction to send the data. Only if
no data is arriving does the software request them, so as to be compatible also with other
instruments.

Changes in version 5.0

The changes are many, and only the most important are mentioned here.

File Format

The software now saves the data in the instrument binary format (*.1d2) during download. This
means that the Net Address is not saved, but when reading the files again the software interprets
characters 6 and 7 as a hexadecimal NetAddr (a convention from the LogDator logger, which
creates file names of the form YYMDDNNx.Id2 where YY is decimal year, M is hexadecimal



month, DD is decimal day, NN is hexadecimal net address, and x is a character from A to Z to
separate multiple files created the same day.

The user can also manually save a “work file” *.sm5, similar to the old file formats *.sm2,
*.sm3, and *.sm4. The advantage with *.1d2 is space, and that it retains the most original record
of the data.

Data View

The Data View window has been completely redesigned, featuring multiple tabs instead of graphs
side by side. This enables each graph to be larger, while at the same time making the window
smaller so it fits even inside a small laptop screen.

The internal manipulation of data has also changed so as to allow for future expansion of
sensors and instruments, with dynamic rather than static allocation of channel names and units.

The data plot graph that assumed constant time interval has been replaced with an X-Y graph,
so that missing data or extra (CBM) measurements are plotted correctly on the time scale. The
sacrifice that had to be made was to give up the secondary Y-axis.

There is a new method of real-time monitoring, for those instruments that send out data over
RS485 while measuring. SediTrans supports this, and SediMeter SM4 will in the future. The
software simply listends to the network and presents, and optionally saves, whatever it picks up.

Control

The main change is that the Timing tab now also has a button for starting and stopping logging, so
that you don’t have to go back and forth to the System tab (which is still there, for independent
control over the mode and baud rate). Three tabs now control the three most important things:
Connect, set up, and download. In most cases you will only need to use those three tabs.

Change in version 4.2
This is based on a new runtime engine, LabVIEW 2018.

Changes from version 4.0 to version 4.1

Data Flow

In 4.1 the Data window is the center of operations as regards the analyzis of data and monitoring.
Opening files, editing files, exporting files, real time monitoring; all of it is done, initiated,
terminated in this window (or in windows opened from and closed back to this window). The data
in memory is not automatically sent back to the Control window when the Data window is closed.

In comparison, the Control window was the center of all operations in version 4.0. Now it is
only used for communication to the instruments, and for initiating contact for master monitoring
(the actual monitoring being started subsequenctly from the Data window).

Slave Monitoring

Version 4.1 can read raw memory files (i.e., direct copies of the SediMeter data record saved to
file by a third party logger or application) and present the data in real time. The master monitoring
mode from version 4.0 is of course also available. This allows users to connect the SediMeter to



third party loggers, side by side with other sensors, and still take benefit of the SediMeter software
for analysis.

Web Server, Auto Rotate

The web server has been reactivated, and an auto rotate between IDs has been added to make it
more useful in a network.

Turbidity Units

Throughout the manual and the software, a number of units for turbidity are mentioned. They are
all variants of FTU and the use of different abbreviations is done in order to distinguish between
measurement methods, since different methods (light wavelength, and angle of measurement in
relation to incident light) affects the results.

Standard units

FTU = Formazin Turbidity Units, signifies that the instrument has been calibrated using Formazin,
regardless of measurement method.

NTU = Nephelometric Turbidity Units, as FTU but measured according to the EPA method, i.e.,
white light scattered at 90° angle.

FNU = Formazin Nephelometric Units, as FTU but measured according to the ISO 7027 method
of near infrared (NIR) light scattered at 90° angle. The wavelength should be centered around 850
nm.

FBU = Formazin Backscatter Units, as FTU but measured as close to 180° scattered back to
towards the light source. In the SediMeter this is measured with NIR light centered around 945
nm.

Proprietory units

FNMU = Formazin Nephelometric Mixed Unit, this is a mixture calculated in the software from
the SediMeter SM3 data by taking the average of the top 6 straight backscatter measurements, and
the top 6 oblique (nephelometric) measurements, all taken in 945 nm NIR light, and combined so
that at low FTU only the oblique values are used, at high FTU only the straight values, and in
between they are smoothly mixed.

NFU = Nephelometric Fluorescence Units, this unit is used for measurements where UVA light
(365 nm) is measured as 90° scattered visible (white) light and calibrated using Formazin. The
UVA LED emits some visible light above 400 nm, and the photodetector is somewhat sensitive to
wavelengths shorter than 400 nm, why the NFU value may be larger than zero even in the total
absence of fluorescence. This value should be evaluated in conjunction with the NTU value (which
is measured coaxially and using the same photodetector) and BFU (see below).

BFU = Backscatter Fluorescence Units, this unit is used for measurements where UV A light (365
nm) is measured as 180° backscattered visible (white) light and calibrated using Formazin. The
UVA LED emits some visible light above 400 nm, and the photodetector is somewhat sensitive to
wavelengths shorter than 400 nm, why the BFU value may be larger than zero even in the total
absence of fluorescence. This value is measured using the same photodetector as the NFU value
(see above) but a different UV LED.



The Two Essential Windows

The Control window is the window that opens with the application. It is
used for establishing communication with the instrument, to set up
logging, and to download data. To use the Control window you must have
a USB-t0-RS485 cable connected, and an instrument in the other end (to
avoid just getting error messages back).

The Data window is used for displaying the data, both logged data,
data from files, and data in real time. You can open the Data window even
without an instrument connected. You do that through the Data ->
Monitor and Display... menu as shown to the right. You can skip directly
to read about the Data window here.

SediMeter Control window

Wl sediMeter Control - X

File Edit [EEEY Window Help
Networl _Monitor and Display...  fing

Connection I Timing | Download
Open and Close (Virtual) Serial Port

Serial Port
2 -
Baud Rate

Connection Method

‘\ USB cable

Open Connection

When starting the application, the SediMeter Control window appears. The Connection tab is open,
and the other tabs are inaccessible until a connection is established as described below.

Connection tab

Serial Port pull-down menu

File Edit Data Window Help

System
Timing

Network I
Connection

I Cleaning |
| Download

Open and Close (Virtual) Serial Port

Serial Port
K coms =
Baud Rate

9600

Connection Method

“ USB cable

Open Connection

Baud Rate

baud rate here before connecting.

Connection Method

— Select USB cable (which is actually an adapter
e A to RS485) or SediLink radio, depending on how
you have connected the SediMeter(s). If you select radio an indicator for
successful establishment of Telemetry connection will appear.

Send To: i(‘ 1

Select the COM port the SediMeter is connected to. Use the Refresh
option if you connect the cable after the application was started.

The default baud rate of the SediMeter after a Reset is 9600. If you have
set an instrument to another baud rate previously, then you must set that

File Edit Data Window Help
Network | System

Connection | Timing | Download

| Cleaning |

Open and Close (Virtual) Serial Port
Serial Port
g coms =
Baud Rate
9600
Connection Method

* SediLink radio

Open Connection

@ Telemetry OFF

Reply From: |1 I

Send To: 7 1




Open Connection button

[
Fie Edt Dato Window Help Click to open the serial port after plugging in the USB connector of the
— I| iv:"'g } . | cable or the radio. If there is no error the remaining tabs get unlocked,
Open and Close (Virtua)Seil Port and the footer of the window becomes un-dimmed.
Serial Port
e Footnote

Most users can ignore the footer. Only those using real time monitoring
o with more than one instrument need to bother.

A : Every message that is transmitted starts with a one-byte address code,
SN the NetAddr (aka SediMeter ID, or RS485 ID). A value of 0 (zero)
signifies a broadcast to all connected instruments. A value of 1 to 255 is
wire ) ayremyi | USCd to address a specific SediMeter.

Use 0 for broadcast commands (e.g., if you want to synchronize the
time of all connected units). However, to get a reply from an instrument, you must enter that
SediMeter’s NetAddr in the Send To field. The Reply From field will show which unit replied.

Connection Method

Timing tab

As this tab is opened, the software automatically performs a GET operation (similar to the user
pressing the GET button) and populates the indicators with the values if there is an instrument
connected with a network address that matches the Send To number.

Computer Time indicator

This indicates the present date and time that the computer is set to.
When you click SET, the software always updates the SediMeter clock from the computer
clock, so make sure your computer clock is set correctly.



SediMeter Time indicator

File Edit Data Window Help

This indicates the date and time in the SediMeter the last
time GET was pressed (or the pane opened).

Network I System I Cleaning :
dt (s) indicator Connection Timing | Download
When the SediMeter clock is read, the difference Clock and Sampling Interval
compared to the computer clock is calculated and the Computer Time Faie
number of seconds is shown in this indicator. A positive | 2019-06-11 21:09:06 UTC utC
value means that the SediMeter is ahead of the computer SediMeter Time dt s
clock. | 2019-06-11 21:09:00 UTC |-0.81307

. N i Burst Interval
Start Time control/indicator P =

{02:00:00 Jo0:05:00 | “Jo.10(¢

The start time for self-timed logging in the format 30 | Samples

hh:mm:ss. The next time that the SediMeter clock reaches
this time, and it is in Logging Mode, it will start logging.
Each time a measurement is made, this setting in the
SediMeter will be increased by the amount specified as
the Interval. As an indicator, it always shows the time of
the next measurement.

START LOGGING MODE

Send To: 1)'1—

Reply From: |1

Interval control/indicator

The interval between measurements in hh:mm:ss. The minimum value you can set is 1 s. However,
the software will not allow you to set a shorter value than the Min Interval that it calculates (see
below). Since in SM4 the burst sampling of accelerometer data is fixed (in the calibration), the
minimum is typically 2 or 3 seconds. In SM3 you can set it to 1 s but it is not recommended, since
you will have a very short time window for re-establishing control over the instrument (as it does
not listen to commands while measuring).

Zone

Selects whether to display the time as UTC or local time. This affects the values in Computer
Time, SediMeter Time, and Start Time. (Internally in the SediMeter the time is always stored as
UTC to avoid having to deal with time zones or seasonal time changes).

Burst Interval and Samples controls/indicators

SediMeter SM3 instruments

The number of burst samples to take per measurement, and the time interval between them. The
interval can be from 1 to 16 seconds, and the number of samples can be from 1 to 20. The
parameters are level and turbidity in the #37 OBS detector (11 cm above #36).

The samples are taken after the start of the measurement, and the measurement does not end
until all the samples have been taken. During this time, the instrument will not listen to commands.



SediMeter SM4 instruments

These are indicators only since the values are determined by the calibration file. In SM4 these refer
to accelerometer measurements. These samples are taken before the end of the measurement. This
is to allow a measurement to be triggered by an accelerometer event, and the triggering event to
be captured in the data.

SediTrans ST1 instruments

The number of burst samples to take per measurement, and the time interval between them. The
interval can be 1 or 2 seconds, and the number of samples can be 1 or 60. The parameter read is
pressure.

SET button

Sends the timing values from the controls to the instrument in the Send To field, or to all connected
instruments if the Send To field equals 0.

GET button

Retrieves the settings from the instrument whose NetAddr | File Edit Data Window Help

is selected in the Send To, and updates all the indicators. Network | System | Cleaning

When this tab is opened, a GET command is sent e Timing | Trrnlast

automatlcally : Clock and Sampling Interval

Logging button Computer Time Zone
|2019-06-11 21:09:42 UTC uTC

This button causes the mode to change between Sleep
mode and Logger mode. When the pane is opened with
the instrument in Sleep mode, the button appears greyed
out and read “START LOGGING MODE”. After sending Start Time _ Interval FriEe
a SET command it will become active and you can change 0200:00  [Jo005:00 {0100

the mode to Logger mode, which will cause the button to 30 | Samples

become bright green and read “INSTRUMENT IS .
LOGGING” e |

If the instrument is in Logger mode when the pane is
opened, the button will appear bright green immediately. INSTRUMENT IS LOGGING
Notice that while the instrument is in Logger mode you
cannot download data; you must first put it back to Sleep. Send Tor :),1— Reply From: [1 !

SediMeter Time dt (s)
|2019-06-11 21:09:00 UTC |-0.81 307

Download tab

This is for downloading data from the instrument, and for erasing the memory. (Broadcasts are not
supported for any action on this tab, which means that you cannot put O in the Send To control.)



CHECK button

Click this to request information from the SediMeter and
update the associated indicators. It is also automatically
done when you open the pane. The following indicators are
populated by this command:

File Edit Data Window Help
Network System l Cleaning

Connection

Memory Usage indicator

Memory Usage
NewRecords: | 53 Size:| 32768
Total Records: | 65 Free:| 32703

El Download to File:

A
%
v

Data to Download

Blue color indicates new data, whereas red color indicates
old data (blue = new, red = read). Data may be marked as
old in three ways: by being downloaded, by being
discarded (see below); or after an instrument Reset.

Total Records indicator

The number of records currently in the internal memory.

@ New Data Only New Records indicator

o

Reply From: |1

The number of records that have been recorded but not yet
marked as read. When full, the instrument stops recording.

Send To: 1

Size indicator

The total number of records the memory can hold. Sec

T File Edit Data Window Help
Free indicator

Network System I Cleaning
The number of records that are still unused. Connection Timing  Download
Download to File control L nElts
Click on the folder button and enter the path and file name

New Records: | 53 Size:| 32768

for where to save the downloaded data.
The data will be saved as a raw copy of the instrument

Total Records: | 65 Free:| 32703

Data to Download radio buttons

memory using an *.sd2 file extension. You are free to E‘ Download to File:

create any name you want, but if you want to keep track of C:\Lindorm\SediMeter\ A

the Network Address of the instrument you should put that g Measurements\Test File.Id2

in position 6 and 7 (this is a legacy of the LogDator file I_— v

naming method of YYMDDNNXx.Id2, where NN is the Data to Download -

network address in hexadecimal notation). ® New Data O _
S

=T

Select whether to download only the new data, or all data.
Do this before clicking the Download button. Send To: 1|1 Reply From: | 1




Download button n

Clicking this button downloads the new records from the selected
SediMeter to the indicated file. (You may have to click on the folder
button in order for this button to get active, even if there is a file path
in the box.)

While the data is being downloaded a progress window will

Progress

appear. When done this window closes and you can use the menu to open the data window to

inspect the data.

< | Discard New button

File Edit Data Window Help

System
Timing

Network I I Cleaning

Connection |

Memory Usage

NewRecordsI 0 Size:l 32768
TotalRecorng 65 Fyee:l 32703

If you want to erase the memory without having
to download the new data first, then you can use
this button to mark them as read.

Download

Erase All button

E‘ Download to File:
C:\Lindorm\SediMeter\ [} . .
3 Measurements Test ile a2 This erases all records, freeing up the memory.
e r | While this is going on a Fed 1nd1§ator appears
O New Dota Orly (left). When done, the indicator disappears and
Discard New . . . .
S/Alpse ’ s | an automatic CHECK is executed, which will
Souie I il dim out all the buttons and controls (right).

An erase cannot be executed while there are
new data in memory. If you don’t want to download the new data, use the
Discard New button.

Network tab

This tab contains a list of the instruments that will be interrogated for data
in real time monitoring. As the default instrument ID (NetAddr) is 1, the
default SediMeter list contains a single record with NetAddr 1, for
convenience. However, if you change the instrument NetAddr or add
additional instruments with other IDs, then you must edit this setting. The
setting is stored as a separate file, and can also be edited in the Edit menu
(see below) so that you don’t have to redo it every time you open the
application.

You can also press the Roll Call button to automatically populate the
records with the NetAddr (ID) list.

The location of the instruments is optional to enter. If entered, they
permit you to see a map of the instruments (it is available as a menu item
in the Data View window).

File Edit Data Window Help

System
Timing

Network |
Connection I

_ Memory Usage
I

New Records: I 0 Size: I 32768
Total Records: I—D Free: lﬁ

= ’ Download to File:

C:\Lindorm\SediMeter' A
9 Measurements\Test File.ld2

I Cleaning
Download

v

L emen |
Reply From: [1—4

Data to Download

O New Data Only
@ All Data

Send To: ”I1

File Edit Data Window Help
Connection | Timing | Download |
Network | System | Cleaning
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System tab

This tab can also be used for turning Logger mode on and
off in the SediMeter. The settings are grouped in two =
groups. Mode and baud rate are changed in the instrument | File Edit Data Window Help

using the SET button, while the instrument’s Net Address Connection |  Timing | Download |
is changed using the CHANGE button. Network System | T {
Mode control/indicator Changing these settings may cause you to

lose connection with the instrument!
SediMeter SM3 and SM4 have two modes, Sleep which is Mode
the universal mode, and Logger, which is only used for ;)|S|eep Eefiailiioge]

stand-alone self-timed logging with data stored to the
. RS485 Baud Rate  §yccess
internal memory. ')W
To start logging, select Logger here and click SET. -
After you switched to Logger mode you can no longer ’E
change timing or cleaning settings, nor can you empty the
memory, so all of that you should do first. Changing mode
is the very last step.

B

New Net Address ID
RS-485 Baud Rate control/indicator g -

This refers to the baud rate in the instrument. The default
is 9600 baud (with 8 data bits, 1 stop bit, and no parity). S T ’)]1_ Reply From: |1_
You can change this to 115,200 baud. The software will
automatically switch to 115,200 baud as well. However, if the software does not switch you will
lose communication. If so, return to the Connection tab, disconnect, change the baud rate in the
software there, and click Connect again.

The higher baud rate allows for faster data download, and less current drain when using radios.

The lower baud rate gives greater range when using radios, and allows for longer cables when
doing real-time monitoring in a physically connected network.

If you are servicing an instrument used for stand-alone logging you will also want to charge
the battery. Charging the battery takes about as much time as downloading data over 9600 baud,
so you might as well use the lower baud rate in that case.

SET button

Clicking this button sends the values of the mode and baud rate.

Success indicator

The Success indicator turns green if the instrument accepted the changes, but it turns red (and the
mode setting reverts) if the change was not accepted.

GET button

Clicking this retrieves the mode and baud rate setting from the selected SediMeter and updates the
respective fields. This command is sent automatically when the tab is opened.



New NetAddr control

This changes the NetAddr (aka SediMeter ID) in the instrument. Each instrument on an RS-485
network must have a unique number in the range 1 < NetAddr < 255.

CHANGE button

Click to change the NetAddr in a SediMeter. The usage depends on how you are connected, as
follows. The new NetAddr number remains in the instrument even after a Reset. Only change this
if you need to have more than one instrument on the same real-time network. WARNING:
Clicking this button may cause you to lose contact with the instrument! You must follow the

instructions below to the letter if you decide to change ID. We highly recommend you do this
BEFORE deployment.

Method for changing NetAddr (SediMeter ID) in an instrument:

1. Enter the new value in the New NetAddr field.

2. Enter the old value in the Send To field.

3. Click SET. The Reply From field will say 0, since no reply is sent.

4. Enter the new NetAddr in the Send To field.

5. Click the GET button, which updates the Reply From field.

6. Verify that communication works by checking that Reply From equals Send To.
Cleaning tab
This tab contains the control for the UV LEDs of SM4, the vibrator of =
SM4, and the mechanical cleaning shuttle of SM3B (legacy). The usage | et ose window rep
depends on the type of cleaner on the instrument. Er IR M

Network |  System Cleaning

Manually Activate Motor or UV LEDs

Manually Activate Motor or UV LEDs o
. . . 4250 ms

These buttons permits manually activating the UV LEDs or the motor.

UV Blink Interval (seconds) ‘:‘,’;’ﬂ'(:j";‘:":;

In SM4, the UV lights will blink with the interval in seconds selected here. Mg and VratorSetings

The interval may be adjusted by the instrument later to account for the o o

fouling conditions.

Send To: :)’1— Reply From: '1—

Wiper and Vibrator Settings

In SM4 it refers to the vibrator motor while in SM3B it is the setting for the mechanical wiper.
Wiping Interval is in units of measurements. That is, if set to 2, it will activate every second
measurement. A setting of O turns it off.

The Next Wiping allows specifying an initial period without cleanings. If set to 0, there will be
no activation; 1 means it will activate at the 1+ measurement, and so on.

Control Window Menus
NB: Need to update this section.



File menu

Exit Ctrl+Q
Quits the application.

Edit menu
I SediMeter Control . X
Cut CtrI+X File m Data Window Help
. L. . Dc ’al Time
Removes the selected text from a field and places it in the clipboard. | ca Mode
Raw Data... t
COpy th'/‘*‘C SediMeter List...
Radio Network...
Creates a copy of the selected text in the clipboard. Turbidity Offset
Advanced >
PaSte Ctr/+V Connection Method
Creates a copy of the text in the clipboard in the selected field at the J &
place of the insertion cursor. Open Connection
-
Raw Data...
Opens the File view window (see below) with the data presently in Send Tor 21 RepyFom [0

memory. If there are no data in memory, it opens as untitled.sm4.

SediMeter List...

Opens the SediMeter List window, for editing the list of connected instruments (see below).

Radio Network. ..

Opens a window for changing settings in the radio in connected SediLink radio modems. The
radios are XBee radios from Digi, and for commands refer to their documentation. If Telemetry is
not connected (i.e., you are using a cable and not radio) then this dialog will serve no purpose.

Turbidity Offset

Opens the Turbidity Offset window (see below). Allows for recalibration of the turbidimeter offset
without changing the slope. This can be done by the operator and even in the field if a suitable
tank is available (known FTU, sufficiently large, darkness).

Advanced > Recalibrate Instrument...
Opens the Recalibrate Instrument window. The Recalibrate window is password protected,
allowing for access being limited to only authorized personnel.

Advanced > Listen to Communication Port...

The window that opens (see below) is intended for debugging an RS-485 network between some
other master, and one or more SediMeters. The software passively displays the data on the
communication port.



Data menu

Monitor and Display... Ctrl+M 3 scdMeter Contral | — x
. . . File Edit [EEEY Window Help |
Opens the SediMeter Data window (see below). For real time P Analyze Logged...  CtrivA ]

monitoring in Master mode, you must Connect to an instrument Or | Dewnloz
Connectic

instrument network before opening this window. T
Open and Close (Virtual) Serial Port

Serial Port

Window menu % com37 =
The content of this menu is a list of the currently open windows of ;a[;ioi
the application. Do not use this menu to switch between windows. Conmection Method
You must instead close the last opened window from its File menu 2 USBeable
in order to return to the previous window. A
Open Connection
Help menu =
ShOW Tlp StrIpS CtrI+T Send To: 1 Reply From: |0 JJ

Turns off or back on the tip strips that appear when you idle the mouse above a control or indicator.

Show Context Help Ctrl+H

Turns on or back off a context-sensitive help window. It displays more in depth help about the
items you idle over with the mouse, than the tip strips provide.

About...

Shows the About window. Click anywhere in it to close it.



SediMeter Data window

This window is for viewing and interacting with SediMeter data, whether downloaded data from
the logger, or for real time monitoring. It has a number of tabs for presenting the data and
controlling real-time monitoring. Two of the tabs are only relevant for SediMeter instruments, but
the rest are relevant also for SediTrans instruments.

SediMeter Plot tab

This graph shows the SediMeter data with time on the X-axis, turbidity detector on the Y-axis, and
signal level as color. The color scale is indicated on the Z-scale ramp to the right of the graph itself.

File Edit Monitoring Share View Window Help
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The color scale is editable. Move the mouse over a scale marker. When the cursor changes to
a double arrow you can drag the scale marker up or down. You can also right-click it and change
its color. If you drag from the end markers you get new intermediate points.

In the top margin of the window the number of samples is shown. In real time monitoring, the
date and time appears to the left of Samples.

NetID control
If data from more than one instrument is analyzed simultaneously, this control is used for selecting
which instrument to display. The control is repeated in the following tabs.

Redraw, Reset, Adjust buttons

Redraw simply redraws everything. Reset changes the color scale of the Z-scale ramp to the default
and redraws. Adjust changes the color scale to the range present in the straight backscatter data
and redraws.



Turbidity radio buttons

Select whether to display only the straight backscatter (36 values), only the oblique scatter (35
values), or both (71 values).

Limit Bottom Search

In some cases there are conditions that confuse the automatic bottom-tracking algorithm, such as
anoxic (black) sediments under the surface, or a piece of seagrass that has got stuck in the sensor.
These controls allow you to force the software to look for the bottom only in the region you specify.

Cycle Through IDs

Rotates through the IDs with the rate selected in the control that opens when active. This is only
relevant for real-time monitoring.

Manipulating the Graph
The graphs share many features, see below in the section Graph controls.

Data Plot tab

This graph plots the measurement data with one value per measurement. The quantities, or
channels, are listed in the legend to the right. The parameters depend on the instrument currently
shown. Each channel can be turned on and off in the plot, its color and type changed, etc.

Note that the SediMeter level is calculated both in the instrument firmware and in this software.
The software is by default automatic but can be changed to interactive mode (see Adjustments
tab).

Graph controls

A number of controls are common for the different graphs. They are explained here.
In the top left corner of the graph is a square button that fixes the scale to O to 36 and disables
vertical autoscaling. This is a useful default scale for SediMeter level.

Graph cursor

One or more cursors can be defined for each graph. To the right of the cursor name and icon there
are columns for the cursor’s current X position, Y position, and in the case of the intensity graph,
the Z value at that point.

If the cursor is not visible in the graph, right-click the cursor (+) in the cursor control and select
“Bring to Center”. To be able to drag the cursor in the chart, make sure the cursor symbol (+) is
selected in the Graph Palette (see below). You can also move the cursor by clicking on the
diamond-shaped controls to the right of the cursor control.

The cursor for the line graph will snap to a line. Right-click on the cursor in the cursor control
to bring up the context-sensitive menu and select which line to snap to.

Graph Palette

In the top right corner there is a palette with three choices; cursor, magnifying glass, and a hand
for dragging. The magnifying choices are, from left to right on the first line: Zoom in in both



File Edit Monitoring Share View Window Help
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dimensions, zoom in in the X dimension, zoom in in the Y dimension. On the second line: Fit all
data to the graph, zoom in to the point of clicking, zoom out around the point of clicking.

Changing X and Y axis scales

The X-axes all have auto scale as default. To turn off auto scaling right-click on the graph or on
the X-axis to bring up a menu where you can turn off “AutoScale X” or, in the Data Plot tab, use
the scale palette.

The intensity graph has manual scaling on the Y-axis, from O to 36. If you change the scale and
want to restore it, simply click the green square button in the top left.

Other features

You can change the legend color, line type etc., and edit the names in the legend.

The intensity graph can be exported as an image by using the Copy Data command in the
context-sensitive menu. The exported image includes all items that presently are visible. You may
wish to turn off the Graph Palette and the Cursor Legend prior to copying the image. You do that
by bringing up the context-sensitive menu (right-click) and de-select them under Visible Items.

The other graphs can be exported as a simplified image (better for including in a report) in a
similar way.

Each graph also has a Scale Legend, although it is off as default in the SediMeter Plot tab. The
scale legend provides a graphical user interface for setting AutoScale, to scale-to-data once, and
for accessing menus for changing a number of settings of the graphs. To turn it on, right-click the
graph and select Visible Items -> Scale Legend.

The line graphs have an Annotation feature. Right-click on a line to bring up a context-sensitive
menu with Create Annotation as one choice. After you have created it you can change its color
and other attributes. This may be used for marking in the graph when certain things happened,
such as taking a calibration reading with another method.



Data Table tab

This is a table of the same data as in the Data Plot tab. The column labels depend on the instrument,
just as the Legend in the Data Plot.

B sediMeter Data
File Edit Monitoring Share View Window Help

| sl [ synopticNetworkDate [ SediMeterFolseColor

Date & Time (UTC) | Level (app.) (cr| Level (inst| Temp (degC]| Light (Ix) 1SO Turbidity (FNU) EPA Turbidity (NTU) Fluoresc 90deg (N| Fluoresc 180deg (BFU| NIR light (bits) | Tilt (deg) | Vibration (m/s2]
2018-12-16 20:24:00 | 8.64 8.68 27.86 . 2827.00 1.00 0.00 25.00 13.00 3167.00 1.07
2018-12-16 20:25:00 | 8.63 8.68 26.82 . 3495.00 0.00 0.00 17.00 13.00 4007.00 11
2018-12-16 20:26:00 | 8.64 8.68 26.15 . 3395.00 10.00 0.00 0.00 0.00 3874.00 112
2018-12-16 20:27:00 | 8.64 8.68 25.79 . 3270.00 0.00 0.00 0.00 0.00 3694.00 1.04
2018-12-16 20:28:00 | 8.65 8.69 2551 . 3141.00 1.00 0.00 0.00 0.00 3570.00 112
2018-12-16 20:29:00 | 8.65 8.69 25.39 . 3036.00 1.00 0.00 23.00 13.00 3458.00 1.01
2018-12-16 20:30:00 | 10.12 10.08 25.30 . 3079.00 0.00 0.00 0.00 0.00 3485.00 1.00
2018-12-16 20:31:00 | 10.31 10.32 25.25 . 3503.00 1.00 0.00 20.00 12.00 4000.00 1.08
2018-12-16 20:32:00 | 10.31 1032 25.23 . 3479.00 0.00 0.00 0.00 2.00 3998.00 1.01
2018-12-16 20:33:00 | 10.31 10.32 2522 . 3175.00 6.00 29.00 88.00 42.00 3591.00 0.96
2018-12-16 20:34:00 | 10.31 1032 25.21 . 3251.00 1.00 0.00 0.00 4.00 3709.00 0.92
2018-12-16 20:35:00 | 10.31 1032 25.23 . 3293.00 0.00 0.00 0.00 2,00 3759.00 1.04
2018-12-16 20:36:00 | 10.32 1033 25.19 . 3170.00 0.00 0.00 13.00 11.00 3614.00 1.07
2018-12-16 20:37:00 | 10.32 1033 25.21 . 3160.00 0.00 0.00 0.00 0.00 3580.00 117
2018-12-16 20:38:00 | 10.32 10.33 2520 I 3153.00 0.00 0.00 0.00 0.00 3619.00 0.99
2018-12-16 20:3%:00 | 10.35 1038 25.19 . 3129.00 0.00 0.00 0.00 0.00 3595.00 123
2018-12-16 20:40:00 | 10.36 1038 25.20 . 3017.00 200 5.00 35.00 21.00 3425.00 0.90
2018-12-16 20:41:00 | 10.36 10.38 25.20 : 3063.00 0.00 0.00 0.00 5.00 3516.00 1.10
2018-12-16 20:42:00 | 10.35 1038 25.19 . 2985.00 0.00 0.00 0.00 0.00 3423.00 1.04

You can save the contents of this table at any time as a tab-delimited text file by clicking the
EXPORT AS TEXT FILE button. You can also save all data from the File menu; that export will
include the SediMeter OBS data and the burst data, which are not included here.



Burst Samples tab

This graph contains the burst sample data from one measurement at a time. In SM3 this is level

File Edit Monitoring Share View Window Help
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and OBS turbidity from OBS #37; in the case of SM4 it is accelerometer data; and in the case of
ST1 it is pressure data. Select which one to display by double-clicking its name in the Select Data
list.

Synoptic Network Data tab

This tab is for real time monitoring. It has three real-time modes (selectable under the Monitoring
menu), and they are

1. Listen mode (instruments in Logging mode control their timing internally, and store the
values in their internal memory but it can also be stored by the computer),

2. Control mode (the computer is the master that controls the timing and stores the data), and

Repeater mode (a third-party device transmits the data to a file on the hard-disk, which is
then read by the software for presentation in nearly real time).



The first mode is not supported by all instruments, and the third mode is a special case for custom
monitoring systems, so we will focus on the second mode, the default one.

[ sediMeter Data
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Accumulation (cm) | Erosion (cm) | ISO Turbidity (FNU) | EPA Turbidity (NTU) | OBS Turbidity (FBU) | Instrument ID
00 00 0 1

Quick Instructions

Enter the desired Interval in hh:mm:ss (maybe 1 T sediMeterData

minute, 00:01:00). It is a good idea to make sure the "¢ " REGEEER Shere View Window Help
instrument is connected and with the clock set cr._ ""9 _—
correctly, and if relevant, the burst sampling is set as Repeater: Display from Files Created by 3rd Party
desired as well. To start, select Monitoring -> 7 . _
Control Network as Master and wait for data to
come in. To turn off, go again to the same menu item
and unselect it. ; however, your
Network Definition must contain the ID of the instrument you have connected (unless you have

changed some default, it will).

Overview of the window

The main feature is the data table. Below it we have to the left the controls for real-time monitoring
and the files to otionally write to (or read from, the in the case of repeater mode). Below the table
to the right are the settings for sending e-mails in the case of alarms, and further to the right are
the settings for generating said alarms. Above that, in the top right, are the tools for setting the
reference level for each SediMeter (since erosion and accumulation must be calculated as a
difference to a reference level). We now present the individual elements of the window.



Data Table

The table shows the last measurement from each connected instrument in a real-time monitoring
network. Whereas the Data Plot tab shows all the measurements from the one instrument, this tab
shows one measurement from all the instruments.

It calculates the change in elevation from a reference level, and displays it as either
accumulation or erosion. Select with the switch in the top right of the tab whether to use the values
from the instrument firmware, or the ones calculated in software (when using software values, the
displayed accumulation and erosion values reflect the previous measurement). Click the Reset
Reference Levels button to use the value from the first record in memory as reference, or edit the
reference levels manually in the table.

The turbidimeter columns may vary in content depending on the connected instrument(s).

Measuring indicator

This is green during a measurement, and grey in between, in real time monitoring.

Telemetry indicator

This is green when telemetry is on (communication via SediLink radio modem).

Interval

Write the desired measurement interval in Control mode, or the interval between checking the files
in Repeater mode. It has no function in Listen mode. The actual maximum measurement rate that
can be achieved depends on the hardware used (instrument and computer).

Burst Samples

The number of burst samples. It is strongly recommended to set this first in each instrument from
the Control window.

Error Message

An information used for debugging. You may find something useful displayed here, but many
messages you can safely ignore.

Listen and Master Monitoring write-to Files tab

Surveillance indicator

Indicates that the window is in Listen monitoring mode, listening to a network of one or many
instruments.

Master indicator

Indicates that the window is in Control monitoring mode, controlling a network of one or many
instruments.

Log to File checkbox

A combined control and indicator for saving monitoring data to file.



Log File control

The Log File path control is used for creating or selecting one or more files to which to write
monitoring data. The files are written in *.1d2 format, so you must specify which instrument data
(the network ID of that instrument, or NetAddr) goes to which file.

Timing Error indicator

This is a warning for timing errors. It is only visible during real time monitoring.

) Measuring o Timing Error 2019-06-12 20:15:22 UTC Error message

Telemetry Error indicator Qo @ reomiper 5 e [ s
This is a warning for telemetry errors. It is only | mistntonguneiofic | i e fonfis | :
.. . . . . [tog to filets) @ surveillance " Master Measured Interval
visible during real time monitoring. A s s Saie s reli
/)’-0— e 7 New Interval [00.00:10.000
0 = et (ms) o
Waiting, Offset, Measurement Interval, — " (r)““‘
st 15:15:12.178 PM
New Interval, Last Measurement o B B

These aids for debugging telemetry are only
visible during real time monitoring.

Repeater read-from Files tab

Slave indicator

Indicates that the window is acting as a slave in repeater monitoring mode, reading raw data files
from one or many insruments. The files would typically be periodically updated by software of a
third party data logger.

Log File control

The Log File path control is used for selecting one or more files from which to read monitoring
data. The files are in *.1d2 format, so you must specify which instrument ID you want to assign to
which file (the IDs are used by the software for presenting data, and can be any number from 1 to
255). The record size and pointer are populated by the software. (NB. In version 5.0 the software
reads the entire file each update, so avoid creating excessively large files or using an unnecessarily
short Interval )

Alarms

This tab is also for defining alarm conditions and what to do in case they are triggered.

The Alarm Thresholds refer to the accumulation and erosion values. The switch for Turbidity
selects which turbidity value to use, the ISO or U.S. EPA standard (both nephelometric).

When any instrument in the network exceeds the set threshold, the corresponding alarm light
goes red. If the Audible Alarm checkbox is ticked, the computer will also beep for each
measurement when an alarm is triggered.

If the Send Email on Alarm checkbox is ticked (and the relevant fields filled in) an email will
be sent the first time any instrument triggers an alarm. The email will say which alarm was
triggered, and by which instrument. To avoid having an email sent too often, a minimum interval
between emails can be specified. Contact your network administrator if you need help with the
server settings.



SediMeter False Color tab

The false color plot is created by combining the straight and oblique scatter turbidity into a single
image with 5 mm vertical resolution, where yellow represents straight backscatter and blue
represents oblique scatter. Due to the total reflection against air, an exposed sensor will create a
blue image. This color plot is therefore an easy visual aid for those who deploy the instruments in
the intertidal zone.

File Edit Monitoring Share View Window Help
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You can zoom in and out. When zooming out the vertical scale is automatically doubled. You
can also change the luminosity, and make the color scale logarithmic. Like the first tab, this is only
relevant for SediMeter instruments, and will be blank when using e.g. a SediTrans instrument.

Menus

The menu system pf the Data window is described in the following.

= n SediMeter Data
Flle menu Edit Monitoring Share View Window Help
Open... Ctrl+0O Data Plot
Open... Ctrl+o Save

Save As...

Opens an *.sm) file. Also works for importing older *.sm2  import Memory LogFil..
and *sm.3 and *.sm4 files, with some limitations for the older =~ =" et -
ones. The *smX file format contains somewhat processed data
from one to many instruments.

Export Data from this SediMeter...

Close Ctrl+W

Save

Saves changes to the open (*.sm5) file.



Save As...

Save data in memory as an *.sm5 file to a new path or with a new name.

Import Memory Log File...

Imports a data file of type *.1d2 (see Download tab).
The *.1d2 files contain raw

instrument data from a single instrument.

Custom Import Formats

This submenu is for customized import formats. Contact us if you require a customization.

Export Data from this SediMeter...

This item exports the data from the selected instrument as a tab-delimited file. The columns vary
depending on instrument version. The file can be opened by many Spreadsheet applications.

A B C D E F G H | J K L M N (o] P I CG CH cl I FR Fs
Burst
sample
1 SediMeter ID 1 interval (s) 0.1
Level Level Peak
{firmwar ({software} Turbidity Turbidity Temperature Battery Light NIR Tilt  Vibration Acc Fluorescence
2 Date & Time (UTC) e} (cm)  (cm) (FNU) (NTU) (2C) (v) (lux) background (deg) RMS(mg) (mg) (FFU) #0 #1  #2  #71 Xg#l Xg#H2 Zg#29 Zg#30
3 | 2018-01-06 17:55  13.788 13.762 0 0 2329 4076 345 90 88 17.56 42.16 88 3929 3563 3780 0 -1 -1 0 0
4 | 2018-01-06 17:56  13.786 13.769 0 0 2333 4078 332 91 8% 16.82 30.93 93 3945 3548 3762 0 -1 -1 0 0
5 | 2018-01-06 17:57  17.592 17.713 1 1 2334 4036 344 8 89 16.7 40.16 84 3920 3557 3766 1 -0.984 -0.984 0 0
6 | 2018-01-06 17:58  17.587 17.724 0 0 2336 4039 335 92 8 16.22 33.65 95 3917 3550 3766 O -1 -1 0 0
7 | 2018-01-06 17:59  17.604 17.736 0 0 2338 4.082 359 90 89 1496 26.89 88 3915 3553 3761 0 -1 -1.016 0 0

Close... Ctrl+W

Closes the window. This item is not active during an ongoing monitoring. First stop the monitoring
(in the Monitoring menu).

Edit menu

Cut, copy, and Paste work as previously described.

Raw Data

Opens the file view window with the data currently in memory.

Monitoring menu

This menu has three items, one for each monitoring mode. Regardless of which is selected, a
number of menu items will be dimmed during the duration of the monitoring.

Listen to Network in Logging Mode

In this mode the software will passively listen to the RS485 network and display the data received,
using the time code of the data. If you so specify the data will also be saved to file, thus generating
data redundancy. This mode has not been designed for, or tested with, the use of radios.



Control Network as Master

Starts or stops master monitoring mode. You must define the network first, and connect to the
instrument network. To save the data to file, you must also specify a file and start logging in the
Monitoring tab. This mode works with radios.

Repeater: Display from Files Creted by 3 Party (Slave)

Starts or stops slave monitoring mode. You must specify the files to read first. The data
transmission from the instruments to the files is the responsibility of third party devices.

Share menu

Web

This item turns on and off the web server with default port 8000. A checkmark indicates when it
is on.

When on, the web server presents the SediMeter Data window as an image, automatically
updated every 10 seconds. The page can be viewed from any web browser by entering the domain
or IP of the computer in the browser address field. For instance, if the IP is 127.0.0.1, type
http://127.0.0.1:8000/SediMeter.html to view the web page.

The actual document is C:\Lindorm\SediMeter\www\SediMeter.html (provided that C: is the
Windows volume). You can edit that document in a text editor to put in your custom information
before and after the SediMeter Data window.

URL

This menu item displays the address to enter in a local browser to see the data from the web server:
http://localhost:8000/SediMeter.html.

View menu

3D View...
Opens the 3D display window.

Network Map...

This opens the Map of SediMeters window. The coordinates are the ones entered in the Network
window (or imported from file in that window).

Window menu

The content is as previously described.

Help menu

The content is as previously described.



Other Windows

File window

This window shows the raw data files. The data has been reorganized in the software, but this
section has not yet been updated in the manual.

Front panel objects

An *.sm4 file may contain data from a single

. .
instrument, or from a network of up to 255 SediMeters. | . v s
For each instrument there is one record per 5
: . ogData Instrument ‘Lindorm SM4 1.015M4-0016
measurement. This creates a 2D matrix of o oo
. . . . T NetAddr Flags Model
measurements, which occupies the main portion of the o [is foroooni  feros
. . . 65 ime Reserved
front panel. The right-hand side of the window wmmETr p
represents a single record. = e =
’ NIR smbient Light (lux)
Status B ﬁa_z_- 2 I131
Record selector @ ori 085 trh (1) 150 trh ) EPA s 4T
nc Jo B J3124
Use this to step through the records from one and the | === o o D g
same instrument. To find the last record, right-click in o s
the white field to open a context-sensitive menu and suosia il
~ 0
select “Show Last Element”. 3 E::: E::: 5
AccDats ; 2
Instrument selector EZ O
» -84 -] 0 < l2800
Use this to step through synchronous records from Magnetim presswre
different instruments (such as created by a real-time 0 o oo |
. . o n o
monitoring network). r —
Cluster ind icator Path l‘!. Ci\Lindor...\Measurements\Test File.ld2

Each record is a cluster of various elements. This is an
indicator, meaning that the data are not editable. The only possible edit in this window is to remove
records from both ends (see below). This is by design, so as to preserve data integrity.

You don’t need to know what these values mean. They are translated to human-readable form
in the Data View window. If you still want to see what each thing represents, either turn on tip
strips (Ctrl-T) or help (Ctrl-H) and hover over each field.

Records

The total number of records per instrument.

Volt meter

This indicates the minimum voltage in all the records. If the voltage falls close to 3.2 V the
SediMeter will turn off monitoring. If so, you may not have data from the entire deployment
period.



Status

This indicator is currently not used.

File Path and Name
The full path and filename of the present data.

Menus
File menu
untitled.sm5
Open... Ctrl+O Edit Window Help
. . * - Import Log File...
Use this to open a previously created *.sm4 file. MergeLogFie.. Cutom  [REISEE
Merge... Ctrl+M Open Work File...  Ctrl+0 NetAddr
. .. . l15
Not presently supported, the purpose is to join files from Save Work File As... A—
dlfferent instruments recorded with the same timing Bt Tt e |2015-12-1¢
Settlngs . Temp (cK)
Close Ctrl+W 129858
Save Ctrl+S Voit | o NEE
. . . Stat

Saves the current data to the same file as last time. Use this ;u;ﬂine SEERLEE
to save the data after deleting records since the edits are not Jo

. . . File Path and Name Flucresc BFU
automatically committed to file. ﬁ o

~
FlunrRSNIR

Save As...

Opens a browser dialog for picking a new path and file where to save the current data.

Import Memory Log File...

Use this for importing data from the SD or MMC card of a LogDator logger, or *.1d2 files saved
in the Download tab of the Control window.

Export Text File...

This item is mainly provided for development and debugging purposes. A more user-friendly
export method is provided in the Data View window (see above).

This method exports the SediMeter data table as a tab-delimited ASCII file (in decimal, not
hexadecimal, number format). Column one is the FTU value of the straight backscatter data at
levels O cm, 1 cm, etc. Column two is the FTU value of oblique backscatter at levels 0.5 cm, 1.5
cm, etc. Row one is OBS #1, row 36 is OBS #36, of the first measurement of the first SediMeter.
If there are more than one instruments in the *.sm4 file, the first measurements of all the
instruments are first output, followed by the second measurements of all the instruments.

Close Ctrl+W

Closes the window (while keeping the data in memory).



Edit menu

Cut, Copy, and Paste function as previously described.

Delete submenu

These commands permit removing records in either end of the monitoring period. It is useful if
you have data recorded before deployment or after retrieval. To commit any change to disk, you

must select Save or Save As after the deletion.

First Record Ctrl+F
Deletes the first record (with index 0).

Last Record Ctrl+L
Deletes the last record (with index [Records — 1]).

All Preceding

Deletes all records before the one currently showing.

All Following

Deletes all records after the one currently showing.

Window menu

The Window menu functions as previously described.

Help menu

The Help menu functions as previously described.

Turbidity Offset window

NB. This is not yet fully debugged in 5.0. This
window allows for adjusting the offset of the
turbidimeters, both in the SediMeter array, and in
the #37 OBS of SM3, as well as the ISO and EPA
turbidimeters of SM4.

You will need a calibration tank with a liquid
of known turbidity, such as pure, filtered, and de-
gassed water. The tank needs to have at least 20
cm of water in front of the backscatter detectors
and ambient NIR light must be kept out. A
suitably sized tank is a 50-gallon black garbage

n My_SediMeter_Data.sm4

File R Window Help
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bin (round, for strength), or a bathtub lined with black garbage bags (with the instrument suspended
horizontally near the surface, sensors facing down). The black color is an additional protection

against reflection.



Important Notice

You must close this window by clicking either Discard or Accept. If you close the window or the
application by any other means, the instrument will be left uncalibrated. Therefore, you should
finish this operation as soon as possible, for the sake of safety.

Instructions

To zero the OBS array of the SediMeter sensor, as well as the ISO turbidimeter of the SM4, turn
on Zero SediMeter. To zero the #37 turbidimeter of SM3, or the EPA turbidimeter of SM4, turn

on Zero Turbidimeter.

Known FTU

Enter the FTU value of the liquid in the tank. It is O for pure water. Depending on your standard
operating procedures you may want to enter a small positive value to create a deliberate bias. Let
us say that there is +2 FTU in noise. Negative values get reported as 0, which means that you
cannot calculate a meaningful average when the real value is O since half the measurements have
been truncated to 0. If you instead introduce a 43 FTU bias, so that O is reported as 3, and you get
values from 1 to 5 with the normal noise, then you will know from the data that there was no
truncating and you can calculate a true average.

Number of Measurements

Enter the number of measurements you wish to include in the average. Each measurement takes a
few seconds.

Click Measure to start measuring. When the green light turns on it is ready and you can inspect
the values. Notice that the offset is not in FT'U units but in raw bits, which is a numerical value
about 2 to 10 times larger than the FTU offset value, depending on the scaling of each sensor.

Discard or Accept
Finish by either discarding or accepting the new values. YOU MUST DO ONE OF THE TWO.

SediMeter List window

When the application is started it reads the file C:\Lindorm\SediMeter\SM_Network.smnt. The
contents of that file can be inspected and edited in this window, although it is also available in
the Real Time tab of the Control window.

The *.smnt file contains a definition of the SediMeter network, for the purpose of real time
monitoring. The SediMeters listed here will be polled during Master monitoring. If one of
them is not on the network, a time-out error will result. If a SediMeter on the network is not listed
here, it will not get polled.




Front panel objects

SediMeter List

This is a one-dimensional table that you can navigate through using
the horizontal scroll bar. In the right-most position, you see the next
unused position, where you can make a new entry.

{3 SediMeter List
File Edit Window Help

NetAddr Siw
The NetAddr (ID) of a SediMeter, or another compatible instrument EastfLong o
on the network. Netniat fo

< >
Units

IDegrees

The easting or longitude of this instrument. Datum & Projection
ROLL WGS84 -~
. CALL
North/Lat (optional) .

The northing or latitude of this instrument.

Units

The units for East/Long and North/Lat. The options are degrees and meters.

Datum & Projection

A free text description of the projection parameters associated with East/Long and North/Lat.

GET button

Reads the NetList in an attached LogDator logger and updates the SediMeter List accordingly. The
coordinates are not affected. (The LogDator is a separate logger sold by Lindorm, Inc.)

SET button

Writes the NetList to an attached LogDator logger based on the NetAddr values in the SediMeter
List. The coordinates are not copied.

ROLL CALL button

This button queries each of the possible 255 NetAddr values, and updates the SediMeter List. If a
SediMeter in the list does not respond, it is removed; if one responds that was not in the list, it is
added to it; and finally, the list is sorted in NetAddr order. Newly added NetAddr entries get
coordinates (0,0).

You can use this feature to automatically edit the list, and to verify that all units communicate.



Menus
File menu

Open... Ctrl+O

Opens a *.smnt file that you choose. Use this and the Save Copy As... commands to maintain
records of different networks on the same computer.

Save Ctrl+S

Saves the data to the file C:\Lindorm\SediMeter\SM_Network.smnt (provided C: is the Windows
startup volume).

Save Copy As...

Saves a copy of the data to a file and path you select.

Close Ctrl+W

Closes the window (but leaves the data in memory).

Edit menu

Cut, Copy, and Paste work as previously described.

Delete All

Deletes all entries in the SediMeter List (but leaves Units and Datum intact).

Window menu

As previously described.

Help menu

As previously described.

3D display window

This window contains an Active X control showing a 3D view of the SediMeter straight
backscatter data.

Dragging with the mouse changes the point of view. Dragging with the Alt key depressed
zooms in and out. Dragging with the Shift key depressed pans the image.

Map of SediMeters window =

This window contains a single object, a map showing the relative | &
position of the SediMeters in the network. The positions are those é
entered in the SediMeter List window (if no coordinates are entered,
the map will be empty as in this example).

Radio Click OK to close.




Radio Network window

This window allows the settings in the Sedilink
radios to be changed from the SediMeter
application. Refer to the SediLink documentation
for settings.

Sleep period and wake time affects the
communication and also the blinking rate of the
white LEDs in the SediLink.

The bottom half of the window allows generic
commands to be sent and settings to be queried.

The button Enter API Mode and the indicator
above it are used to enable API communication.
When done, click OK. Note that if no radio is
present, an error will result.

Monitor Communication Port
window

The purpose of this window is

{3 Radio Network

Present Sleep Period ~ New Sleep Period

100:00:00.00 ao&o&oo.oo SET 5P
Present Wake Time New Wake Time
100:00:00.000 g 00:00:00.000 SET ST
AT Command
[eman] [srcm |

Present Parameters

o £ 0000 0000

Parameters Input  New Parameters

monitor the traffic on an RS-
network. It can be used for S —
debugging when setting up FEBELAT00
communication between a
third-party logger and the
SediMeter (note that it can not
used to monitor the
communication between the
same instance of
SediMeter.exe and a
SediMeter instrument). The
traffic is  displayed in
hexadecimal code to the left,
as ASCII characters to the
right.

The first 4 bytes are the
message header. In the center
these 4 bytes are decoded,
although the checksum is

2009-05-06 15:32:02UTC

2009-05-06 15:31:59 UTC

o

be

and

analyzed so a value of 00 indicates a valid checksum. The indicator turns green for valid, and red

for invalid checksum.

The window can operate in two modes, continuous and one shot. In continuous mode, it
replaces the content as soon as a new message is received. In one-shot mode, it displays the latest



message until it is rearmed. When the rectangle is green and reads Listening it is waiting for new
traffic.

When the rectangle is red and reads Rearm it is keeping the last message displayed. It is still
receiving messages in the background, queuing them until the rearm button is pressed. One can
thus step through the messages one by one.

Recalibrate

Since the recalibration functions are password protected in order to be accessible only by qualified
and trained personnel, they are left out of this user manual on purpose.



Demo File

Calpe, Spain, 2018

The folder ./Lindorm/Measurements contains an example file recorded with an SM3.2 instrument
off Spain in 2018. The screen capture below shows data from that file in version 4.2 of this
software.

ﬂ SediMeter Data
File Edit Monitoring Share View Window Help

- SediMeter Sensor Chart

28800 SediMeter ID
edraw
PR

30-

Auto Rotate IDs
Turbidity * OFF
7200 | (®) Straight

=]

0~ 1 1 1 { 1 1 0
10:24:00 00:00:00 00:00:00 00:00:00 00:00:00 00:00:00 19:36:00 =
2018-02-07 2018-02-16 2018-02-23 2018-03-02 2018-03-09 2018-03-16 2018-03-24 I B %g;g_m
Data Plot o | - o
1500 =0 L
14.00 -2250
- A
o 2000 [] Level {firmware} (cm)
-1750 Level {software} (cm)
10.00 4 -1500 Turbidity (FBU)
e -1250 Turbidity (FNMU)
-1000 Temperature (°C)
6.00 - ~750 Battery (V)
5.00 i 0 T i T T T -500 Light (lux)
10:24:00 00:00:00 00:00:00 00:00:00 00:00:00 00:00:00 19:32:00
2018-02-07 2018-02-16 2018-02-23 2018-03-02 2018-03-09 2018-03-16 2018-03-24
Data Table | Burst Samples I Monitoring I Network Real-Time Data I Alarms Adjustments Color Plot
Fime (UTC) | Level {firm] Level {soff Turbidity Turbidity (FNM| Temperatu] Battery (V) oo
07 10:24:00 | 5.746 5.685 722 1187 13.70 4.067 0 0 0 0.00 0.00 0 0 1D
07 10:28:00 | 5.764 5.704 727 1210 13.72 4.070 0 0 0 0.00 0.00 0 0 l 0
07 10:32:00 | 5.748 5.688 725 1167 13.69 4.068 0 0 0 0.00 0.00 0 0
07 10:36:00 | 5.752 5.693 722 1160 13.72 4.069 0 0 0 0.00 0.00 0 0
07 10:40:00 | 5.752 5.691 723 1337 13.72 4,069 0 0 0 0.00 0.00 0 0 _!J
«| > [ save 1




